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By Susan Reynolds The only way you can edit a PORTABLE Document Format (PDF) in Microsoft Word is to use a third-party application to transform it into a Word document. It works by reading the text in the PDF and extracting it to a Word file, so you can delete, edit, and add text to the file. Some PDF documents are locked for editing, so you can't turn
them into Word documents. Browse for the PDF you want to edit and click it. Click Transform to Word in the upper-right corner of the menu. The file automatically opens the PDF document in Microsoft Word 2007, so you can edit it in the same way as any other Word document. Edit the document in Word. Use the editing tools in Word to edit, delete, or add
text. For example, cut out text by highlighting and right-clicking on it. Then select Cut to remove and Paste to insert or restore text. Use the Insert function. Add page numbers by going to Insert, and then clicking Page Numbers. Add a header by going to Insert and clicking Header. The Insert feature can also be used to add a cover page, picture, or clip art. Go
to File, select Save As and select PDF from the drop-down menu. Give the file a name and tap Publish. The file will be transformed back into a PDF file. By Foye Robinson Whether you are working with an existing Word document or completed, you can format parts of the document or the entire file. Using bullets and numbering is a quick way to highlight lists
and paragraphs in your document. A wide page margin can be reduced to better match your content. You can use tabs to align objects that are not adjusted correctly with a spacebar. Formatting a document makes a regular one stand out. Create bullets for a list of items or paragraphs by highlighting it on the page. On the ribbon, select the Home tab, and
then click the Numbering or Bullets button. The points will be applied to the selected list. Select the Home tab on the ribbon and select the Multilevel List button to create bullets if the list has more than one level. The Multi-Level List gallery expands, so you can choose the type of list you want to create. To place items below the same level, press the Enter key
after each item. To place below another level, press Enter and then Tab. Items below the new level will be indented. Select the text where the tabs are set, or place the insertion point in the area you want the tabs to use. Select View and Ruler from the ribbon to make the ruler visible. Then click the button to the left of the ruler to select the tab adjustment you
want (left, center, right, decimal, or bar). Each time you click the button, the tab adjustment changes. Select the Left tab for the adjustment. Then click a number (point) on the ruler for enter a left tab there. To enter multiple tabs, click a different number on the To change the tab alignment, change the Left Tab button to another. Place the cursor for text you
want to format and press the Tab key. Your text is formatted under the set tab. On the ribbon, select Page Layout. Then click the Page Setup button to open the Page Setup dialog box. Select the Margins tab and select the margins you want. In the Orientation section, select portrait or landscape for your Page. Click the Layout tab and go to the Page section.
To center the content of the page vertically, change Vertical Alignment to Center. Then click OK to return to the document. Select the amount of text you want to display on a specific page by inserting a page break. To insert the break, select Insert and Page Break from the ribbon. To delete a page break, select View and Draft from the ribbon. Then click on
the page break bar and press the Delete key. Most of us know easy ways to turn a Word or other text document into a PDF file, but what if we need to convert a PDF to Word? Today we will take a look at some methods to turn a PDF document into a Word or other text document. Online Solutions The first couple of solutions are online, so you don't even
need to install software to convert your files... Keep in mind that with these websites, you upload your data to a third party, so consider the privacy implications if you convert sensitive documents. Zamzar without a doubt the most popular online file conversion page is Zamzar. This free service allows you to convert files up to 100MB for free. Just browse to
the PDF file, select the format you want to convert to, and then enter your email address. When the document is ready Zamzar will send you an email with a link to the document to download. Zamzar will also convert a PDF to HTML, ODT, PCX, PNG, PS, RTF and TXT. Use Zamzar Free Online File Conversion PDF Online Another great online service is
PDF Online. This service is powered by BCL Technologies Easy Converter software that you can download a 30 day trial of if you or your company wants to convert a large number of documents. Currently, you can sign up for a BCL Premium Online account that allows you to convert 20 documents per day with a size limit of 10 MB (per document). After
conversion, just right click on the link to save link as an RTF Word document on your PC. Use PDF Online Free PDF Services Free PDF Converter The final online service we will check out is Free PDF Converter. This is similar to zamzar, but the free version is much more limited. I sent the same 4-page PDF document for all tests, and this service cut my
document after 2 pages. They also only allow you to convert a PDF every 30 minutes. The cheapest membership is $9/month where conversions are basically unlimited. a pinch, this site can come in Use free PDF Converter Software Solutions The next set of solutions are software-based applications that can be installed on your local computer and used
offline. These would be a better choice for converting sensitive documents. BCL Easy Converter Desktop 1.0 Since PDF Online impressed me the most with their online conversion service I decided to take their desktop software for a trip. BCL Easy Converter Desktop 1.0 is a very simple but powerful tool to convert PDF documents to Word. It basically works
the same as the online service, but on the desktop. It converts PDF documents to RTF only, but for twenty dollars it can be more useful than wasting time online. You can download a trial version of Easy Converter Desktop or the purchase price is only $19.95. Download a free trial version of BCL Easy Converter Desktop 1.0 DocSmartz Sometimes you may
want to convert the PDF document to other file formats such as Excel, HTML or Postscript. DocSmartz Pro is a great affordable desktop application to get the file format you want. Select the PDF you want to convert, and DocSmartz Pro guides you through different settings with an easy-to-follow wizard. Download DocSmartz Pro ABBYY PDF Transformer 2.0
Another software solution that converts PDF documents to multiple formats is ABBYY PDF Transformer 2.0 which is able to convert PDF files to Word, Excel, RTF, HTML, TXT and a searchable PDF document. In my tests abbyy did a good job of converting PDF files to each format. For a full license of ABBYY Transformer it will set you back $99. Download
PDF Transformer 2.0 Free PDF to Word Doc Converter Finally we get to the good part, the (sort of) FREE version. Free PDF to Word Converter 1.1 is also basic and easy to use as BCC's Easy Converter, but actually has some additional options like choosing a font and selecting page numbers. Conversions were quick and easy even with large documents
with lots of images. However, there is a catch. After the first conversions, you'll be prompted to download a registration code from the site each time you want to convert a document. In order never to enter a registration code, you must pay $15. Download free PDF to Word Converter 1.1 Conclusion After testing the online services it seems that converting a
PDF to RTF (Rich Text Format) seems to work best. When you convert to a Doc format can get quite messy. PDF Online was the fastest, easiest to use, producing the best quality conversions across the other online services. Of the two converters for multiple file formats, DocSmartz Pro was much easier to use and was faster than ABBYY's PDF
Transformer 2.0. If you just need to convert a PDF to Word, Free PDF to Word Doc Converter a few times to irritation to get a code for each document kicking in. To convert PDF to to DocSmartz Pro formats are the best and cheapest. If you just need to convert PDF to Word, BCL Easy Converter Desktop 1.0 is the best option. These are just some of the
services and software tools available, what are some of your favorites? Let us know! A common question I've gotten a lot these days is how to convert a PDF file to Microsoft Word format (doc), Excel format (xls) or JPG image format. Usually people will know how to convert a file to PDF, but it's also nice to be able to convert back the other way. There are
several ways to get the PDF file into any of these three formats, but I'll stick to the simplest methods that require the least software. You can pretty much do all conversions online these days using free tools. Convert PDF to JPG - Online Tools Go to ZamZar.com click the Select Files button to get started. Go ahead and select the PDF, and then click OK. Now
under Step 2, go ahead and select the file type you want to convert the PDF file to. By default, the box determines the file type you selected and gives you the list of possible output file types. You can convert a PDF file, for example, to a doc or docx file, to a bmp, jpg, gif or png file, etc. In our case, we select JPG from the list. Now enter your email address
and click the Convert button. It's about that! You should get an email a few minutes with a link to the converted file. People have complained of significant time delays between clicking converter and actually getting an email. It seems that the site is quite busy, and if you are trying to make a conversion at a very busy time, it can take a few hours or even a day
or two to get the converted file. If this is unacceptable, they have paid monthly plans, but unless you need to convert PDF files all the time, it is not worth buying. If you have problems with Zamzar, you can try another free online PDF to JPG converter: The end result from both sites was very good, but again there is not much that needs to be done to convert
from a PDF to an image. It becomes more difficult when you need to go from PDF to Word or Excel format. Convert PDF to JPG - Desktop Software The first thing you have to do is to download a free software (the only one I could find) that converts PDF documents to JPEG image format automatically. Go to the Omni format download page and download
both Omniformat v8.3 and the PDF995 app. You must download and install PDF995 first before installing Omniformat. Once you have both applications installed, go to start menu programs, locate the Software995 application group and click on Omniformat. The only annoying thing about this program is that it requires you to see some ads in about 30
seconds! However, it's better than paying $20 or $40 for a program just to make a simple pops up another instance of the browser window for the website of each of the sponsors, but it does not install any spyware on the computer (no pop-up ads). Once the program is loaded, you will see it has a section called Watch Folders and then a button at the bottom
titled Start Monitoring and Single Pass. Basically the way it works is that you need to copy PDF files you want to convert to JPG format to C:\omniformat\watch folder and then press Single Pass. The program will look in that directory and convert each page of each PDF into a separate JPG file. If you click Start Monitoring, you can continue to drop PDFs into
this folder, and the program will automatically convert them to JPEG files as long as the program is open. Please note that the program deletes the original PDF document that it uses, so that's why you need to copy the PDF document to the clock folder, not move it! You should now see your converted files as below: Another desktop application you can use
is Free PDF to JPG, which also allows you to convert a PDF to BMP, PNG and TIFF format. Convert PDF to Word Again, Zamzar does a great job with this conversion. Select the file, and then select DOC or DOCX from the list of options in step 2. Enter your email address for step 3 and click Convert. You should receive an email within a few minutes with a
download link to the converted file. I have tried out this service on some pretty complex PDF documents with text in multiple columns, multiple images, etc and have been very impressed with the conversion accuracy. Again, there are other ways to get the PDF file to Word format. Here are some nice free online tools: If you want a desktop application to
convert PDF to Word, you can download one here: Convert PDF to Excel For Excel, it's the same process using Zamzar, which is great as long as they're not busy. Previously, you had to convert the PDF to a TXT file and then import it into Excel and save it as an .xls or .xlsx file. Now, however, it has been updated, and Zamzar fully supports the Excel
format, so you can select it directly in step 2. Other than Zamzar, the second popular choice is from Nitro PDF software, which is also the same company behind pdftoword.com mentioned above: If you have a very complicated PDF file and the formatting is not being converted correctly using these free tools, you may need to invest in a commercial software
package that could possibly do a better job. For example, there is Adobe Acrobat Pro DC, which allows you to convert PDFs to Word, Excel, and even Powerpoint files. Of course, quite expensive ($15 a month) and probably only worth it if your IT department foot foot
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